
Introducing KODAK PRECISION Color 
Configure

KODAK PRECISION Color Configure brings the benefit of 
full color control to your PC desktop.    Whether you're a 
novice or experienced color operator, the KODAK 
PRECISION Color Configure is simple to use and follows 
standard Microsoft Windows conventions.

KODAK PRECISION Color Configure (Color Configure) is a 
desktop utility that works with Aldus PhotoStyler to 
create a fully calibrated and characterized environment.  
The benefits of a color-managed environment include:

·    Stable, repeatable color
·    Simulation of output as it will
·    appear when printed or proofed
·    Conservation of expensive time and materials

This chapter gives an overview of KODAK PRECISION 
Color Configure features and functions and lists the 
equipment you need to operate it.    For more information
on optional Kodak color management products, call 
(800)-752-6567 (U.S.A.) or 508-670-6877. Fax 508-670-
6550.



Color management overview

Color management requires three components:

·    Precision Transforms (also referred to as color profiles)
·    A color processor
·    A color management application, such as Aldus 
PhotoStyler

Precision Transforms (PTs) define the color reproduction 
characteristics of the devices, media, and file formats 
you use.    Each PT defines a very specific component of 
your system: for example, a particular brand and model 
of monitor.    A database of PTs, including input, monitor, 
color printer, proofing, effect, import, and export type 
PTs, is provided with Aldus PhotoStyler.    When installing 
Aldus PhotoStyler, you specify the PTs to be used in your 
system.

Color Configure creates configurations of PTs that 
identify each device in your system and makes this 
information available to the color processor.

The color processor combines or composes configured 
PTs to generate a new set of PTs.    The composed PTs 
define how color information passes from one device to 
another.

Aldus PhotoStyler then uses the composed PTs and color 
processor to color-correct images as they are opened, 
imported, exported, previewed, edited, or output by the 
application.

With this color definition, your system's performance is 
enhanced and images are reproduced with predictable 
and repeatable color quality.



Color Configure functions

Use Color Configure to :

·    Select Precision Transforms (PTs) for your system 
devices and settings
·    Save and/or modify PT selections in a configuration
·    Create new, composed Precision Transforms from a 
configuration of PTs specifically for your devices
·    Delete unwanted Precision Transforms and 
configurations from your system database

These Precision Transforms are obtained from one or 
more of the following sources:

·    With Aldus PhotoStyler
·    Packaged with KODAK PRECISION Color Configure
·    Optional KODAK PRECISION Device Color Profiles 
(DCPs)
·    Optional KODAK PRECISION color calibration and 
characterization software, such as KODAK PRECISION 
Input Color Calibration Software
·    Compatible, non-Kodak color management 
applications that generate color profiles

If you use a device that isn't listed in the PT database, 
you can order device color profiles through Kodak. 

For more information, call (800)-752-6567 (U.S.A.) or 
508-670-6877. Fax 508-670-6550.



Color Configure features

Color Configure features allow:
·    Automatic application of standard highlight and 
contrast effects as files are opened
·    Simulation of images on monitor as output by Aldus 
PhotoStyler on printers and proofers
·    Access to Precision Transforms from a variety of 
applications
·    Image conversion from one color space to another 
upon import and export

All of these features operate in the Microsoft Windows 
environment.



To go to any of the following topics, click on its title:

    Color Management Overview

    Color Configure Functions

    Color Configure Features







Quick-start Procedure

This quick-start procedure is an overview of the steps required 
to create configuration with KODAK PRECISION Color Configure 
software.    The steps below are described in detail in Using 
KODAK PRECISION Color Configure" late in this manual.

With KODAK PRECISION Color Configure fully installed on your 
hard disk, follow these steps to create a configuration.

1.    Open the KODAK PRECISION Color Configure application in 
the control panel.

2.    Select New Configuration from the File menu.    The Color 
Configure 
        dialog box appears.

3.    Click Monitor to select a Monitor Precision Transform.

Note: A Monitor Precision Transform must be specified to create a 
Configuration.    The selected Monitor Precision Transform will be used with all 
configurations you create.

4.    Click on any additional options on the dialog box to 
configure other 
          types of Precision Transforms, including Effects, Monitor 
Proof 
          Agreement (MPA), and Output Precision Transforms.

5.    When you are done configuring Precision Transforms, from 
the File 
          menu, select Save Configuration As...

6.    Type a name for the configuration and click OK.
The PRECISION Transform Composition Box appears and a 
progress bar indicates the percentage of completion. 

When the procedure is complete, the new configuration name 
displays in the Color Configure dialog box.    You can now use it 
with Aldus PhotoStyler.



Using KODAK PRECISION Color Configure

Note: When you first install Aldus PhotoStyler, you have the option to specify 
the components of your computer system, such as the monitor that you use, the
scanner, the printer, and so on.    

If you replace or change one or more of the components used in
your system, use the following procedures to set up a new 
configuration of PTs.

To color correct images, Aldus PhotoStyler needs to know 
certain information about your computer system.    Color 
Configure allows you to gather that information by selecting the
Precision Transforms that represent system components and 
then saving the PTs as a configuration.

Each configuration must have a Monitor PT.    You can further 
specify your system by selecting Input, Input Effect, Output, 
Output Effect, and Monitor Proof Agreement (MPA) Precision 
Transforms.

Your database of Precision Transforms varies with the types of 
Kodak Device Color Profiles you use and with third-party device 
color profiles that you import for use with Color Configure.    

For more information on importing third-party device color 
profiles, see : "Import Filters"

Color Configure consists of a Control Panel icon, online Help, 
and a Main window from which appear a series of dialog boxes, 
pull-down menus, and options.



Starting KODAK PRECISION Color 
Configure

To start Color Configure
1. From the Main Group of the Program Manager dialog 
box, double-click on the Control Panel icon.

The Control Panel dialog box appears, displaying the KODAK PRECISION Color Configure 
control panel icon.

2. Double-click on the Color Configure icon.    The Color Configure Startup dialog box 
appears.



Initially, the system searches for and categorizes all Precision Transforms stored on the 
system and saves this information in a private database file.    Once the database is created, 
subsequent Color Configure startups are faster.

If you change your database, the system repeats the 
initial search and categorization step.

A progress bar on the Startup dialog box monitors the 
process of creating the database and gives the percent 
of completion.    When the process is complete, the 
KODAK PRECISION Color Configure dialog box is brought 
to the foreground of the desktop.



The Color Configure dialog box and menu 
bar

The KODAK PRECISION Color Configure dialog box and 
menu bar display all of the options for configuring your 
system with Precision Transforms.

Color Configure contains several elements common to Windows-based applications, such as 
pull-down menus, option buttons, progress gauges, and list boxes.    Refer to the Microsoft 
Windows user's guide for Windows basics.

When first started, the Color Configure dialog box appears with the default configuration.    
From here, you can access additional dialog boxes for selecting Precision Transforms or for 
viewing PT information.

The menu bar appears at the top of the Color Configure 
dialog box, with the File, Delete, View, and Help pulldown
menus.    These menus allow you to perform a variety of 
file management and printing tasks and are described 
below.



Getting Help

You can get more information about Color Configure 
features and functions through the online Help feature.    
Obtain information about a topic by pulling down the 
Help menu to Search, and then choose a topic.

Using Help gives information on how to use Help, such as how to choose a topic, search for a
topic, place a bookmark holder on a topic, or print information.    The Color Configure Help 
feature follows Windows conventions.    Refer to your Microsoft Windows user's guide for 
more information .

You can also press Fl to access Help at any time during 
your session to get information on the current dialog box
or menu.



To go to any of the following topics, click on its title:

    Dialog Box & Menu

    Getting Help



Configuring your system with Precision 
Transforms

Use the Color Configure dialog box to select the Precision
Transforms that match your devices and settings.    When
you first start up Color Configure, the Color Configure 
dialog box appears with the current configuration 
selected.

When creating a new configuration, or when no PTs are 
saved in a configuration, each option field shows (No 
Selection).    If you previously selected PTs for the Default
configuration, their names are displayed in the Color 
Configure dialog box.

The Monitor option appears at the top of the Color 
Configure dialog box with the name of the configured 
Monitor PT, when selected.    The configuration name 
appears below the Monitor option.    When the 
configuration is unnamed, the configuration name 
appears as Configuration: (Untitled).

If the configuration is the default configuration, (Default) 
appears to the right of the configuration name.

For more information on creating the default configuration and naming configurations, see 
"The File Menu" later in this manual.



Multiple dialog boxes

Color Configure presents a series of dialog boxes that 
correspond to the types of Precision Transforms 
available.    For example, when you click on the Monitor 
button, a Monitor PT dialog box appears and displays all 
available Monitor-type PTs stored in your PT database.

Some types of Precision Transforms such as Input and Output, present an additional level of 
dialog boxes for selecting Effects-and MPA-type PTs.

When you access other PT types, such as proofing system Output PTs, a multiple dialog box 
appears to select the appropriate PT for the settings you use.



Selecting Precision Transforms

You use PT Selection dialog boxes to select the Precision 
Transforms for a configuration.    The procedure for 
choosing PTs is similar for most dialog boxes, with the 
following exceptions:

·    The selected Monitor Precision Transform is applied to 
every saved configuration.    When you change the 
Monitor PT, Color Configure updates each configuration 
to include the newly selected Monitor PT.

·    Effects PT Selection dialog boxes allow you to add, 
remove, and rearrange PTs.

·    Folders within a PT Selection dialog box indicate 
availability of an additional PT Selection dialog box.    The
PTs in this box are specifically for a type of manufacturer 
and/or model of a device.

When you display a saved configuration, the selected PTs
for each type appear in the Color Configure dialog box.    
When you click on a button to access a PT Selection 
dialog box, such as the Input button to select an input-
type PT, the currently selected PT displays The selected 
PT, may appear in reverse video, depending on the way 
you set up your Windows default settings.

As you use Color Configure, you can choose options from
the pull-down menus on the Menu bar.    For example, 
you can save and delete a configuration or obtain Help.   
Menu bar functions are discussed in detail later in this 
chapter. 

PT Selection dialog boxes display a folder symbol to the 
left of the folder name.    A folder symbol indicates 
another PT Selection dialog box is available with an 
additional group of PTs.

You can use the same PT in as many configurations as 
you need. When deleting PTs, you cannot remove PTs 
that are saved in a configuration. PTs you cannot delete 
appear grayed out in the PT Selection dialog box.



PT selection options

PT Selection dialog boxes contain some combination of 
the following options: Select, Done, Cancel, View, and 
Clear.

Select. Adds a selected PT to the current configuration.

Done. Adds selected Effects PTs to the current 
configuration.

Cancel. Displays the Color Configure dialog box without 
making a change to the current configuration.

View. Displays the attributes for the selected PT.    See 
"Viewing PT At tributes" later in this chapter for more 
information.

Note: View is unavailable for folders.    Open the folder to 
display the PT Selection box and view attributes.

Clear. Removes the selected PT from the Color Configure 
dialog box. This option is not available for Monitor-type 
PTs because every configuration requires a Monitor PT.



To add a PT to the current configuration

Add a PT to the current configuration in one of two ways:

·    Click on the PT name displayed in the corresponding 
PT Selection dialog box.    Then, click Select at the 
bottom of the PT dialog box add the PT to the 
configuration.

·    Double click on a PT to automatically add the PT to 
the current configuration.

To select a PT:
1.    From the Color Configure dialog box, click on a 
button to display the list of available folders and PTs.    
For example, to select an Input-type PT, click the Input 
button.    When an additional dialog box is available for 
folders, double-click on the folder icon to display the PTs 
stored within the folder.

2.    Click on the desired PT.    The name of the PT displays in the Color Configure dialog box 
for verification.



Viewing PT attributes

Use the View option, available in PT Selection dialog 
boxes, to display a list of attributes for a selected PT.    
You must select a PT before you can view its attributes.

How much attribute information you use depends on what you need to know about a PT.    
You can set up Color Configure to display some or all of the attributes available for a 
selected PT.    For more information, see "Preferences", later in this chapter.



Types of Precision Transforms

The type of PTs you select such as Input, Monitor, and 
Output depends on the types of devices you use and 
how you operate.    Aldus PhotoStyler uses the PTs you 
configure with Color Configure when you use it to open 
and save images.    For more information about how PTs 
are used, see "The color management system " in the 
Aldus PhotoStyler User Manual.

The following table gives an overview of each type of PT 
you can configure with color Configure.



Selecting a Monitor Precision Transform

Monitor PT selection is unique in that the PT you choose 
automatically becomes part of all saved configurations.    
You cannot create a configuration without a Monitor PT.

 To select a Monitor PT:
1.    Click on Monitor.
The Monitor PT dialog box appears.

All Monitor-type Precision Transforms stored on your system are listed. Monitor PTs must 
have a matching simulation PT to convert color in or out of the monitor's color space.    When
more than one PT matches the selected Monitor PT, a dialog box displays asking you to 
select the appropriate PT.

2.    Double-click on the desired PT or folder.
The Color Configure dialog box redisplays with the name 
of the PT next to Monitor.



Selecting an Input Precision Transform

To select an Input PT:
1.    Click on Input. The Input PT Selection dialog box 
appears.

All Input-type Precision Transforms stored on your system, including scanner and import 
types, are listed.

2.    Double-click on the desired PT or folder.



Selecting Input Effects Precision 
Transforms

To select Input Effects PTs:
1    Click on Effects, located below the Input button.
The Input Effect PT Selection dialog box appears.

All Input Effects-type Precision Transforms stored on your system are listed. 

You can select more than one Effects PT.    Add the same Effects PT to the list as many times 
as you Iike to reapply it during the color correction process as in batch processing.    The PTs 
are applied to an image and processed in the same order they display in the dialog box's 
Selected: list.    The PT at the top of the list is applied first the second PT is applied second 
and so on.

2.    From the Available: list click on the desired PT(s).

3.    Click Add to add the selected PT(s) to the Selected: 
list. 
The name of the selected PT(s) displays in the Selected: 
list.

4.    If needed, click Order to rear-range the order the PTs 
appear on the list.

When you click Order, the arrow cursor changes to a 
number (1,2) cursor. Place the number cursor and click 
on the PT that you want to place at the top of the list.    
Click on a second PT to position it beneath the previously
selected PT.    

For example, if you click on Contrast 1 For LowCon, it 
repositions to the top of the Iist.    If you click on HL 



Cont2 For LowCon, it repositions below Contrast 1 For 
LowCon.    If you click on HL Cont1 For Low Con, it moves 
below HL Cont2 For LowCon. 

Repeat this step until the PTs appear in the desired 
location on the list.

To remove a PT from the Selected: list, select the PT and 
click Remove. The PT transfers from the Selected : list to 
the Available: list.

5.    Click Done when you finish selecting.
The names of the PTs display in the Color Configure 
dialog box.    Use the arrow keys to view the names that 
do not display within the name box.



Selecting an Output Precision Transform

To select an Output PT:
1.    Click on Output.    The Output PT Selection dialog box
appears.

All Output-type Precision Transforms stored on your system are listed, including printer, 
proofer, and export type.    Output and Output Simulation PTs must match to operate in 
output simulation mode.    When more than one Output Simulation PT matches the selected 
Output PT, a dialog box displays requesting that you select the appropriate PT.

If you select an Output Simulation PT without a matching
Output PT, Color Configure cannot compose an Output 
Simulation PT.    The following message appears:



2.    Double-click on the desired PT or folder to select it.



Selecting Output Effects Precision 
Transforms

To select Output Effects PTs:
1.    Click on Effects, located below the Output button.
The Output Effects PT Selection dialog box appears.

All Output Effects-type Precision Transforms stored on your system are listed.

You can select more than one Effect, PT. Add the same Effects PT to the list as many times as
you like to reapply it during the color correction process as in batch processing.    The PTs are
applied to an image and processed in the same order they display in the dialog box's 
Selected: list. The PT at the top of the list is applied first, the second PT is applied second, 
and so on.

2.    From the Available: list, click on the desired PT(s).

3.    Click Add to add the selected PT(s) to the Selected: 
list. 
The name of the selected PT(s) appears in the Selected: 
list.

4.    If needed, click Order to rear-range the order the PTs 
appear on the list. 

When you click Order, the arrow cursor changes to a 
number (1,2) cursor. Place the number cursor and click 
on the PT that you want to place at the top of the list.    
Click on a second PT to position it beneath the previously
selected PT.    

For example, if you click on Snappy Neutrals, it 
repositions to the top of the list.    If you click on Small 



Saturation Boost, it repositions below Snappy Neutrals.

5.    Repeat this step until the PTs appear in the desired 
location on the list. 

To remove a PT from the Selected: list, select the PT and 
click Remove. The PT transfers from the Selected: list to 
the Available: list.

6.    Click Done when you finish selecting. 

The names of the PTs display in the Color Configure 
dialog box.    Use the arrow keys to view the names that 
do not display within the name box.



Selecting an Output MPA Precision 
Transform

To select an Output MPA (Monitor-to-Proof
Agreement) PT:
1.    Click on MPA, located below the Output Effects 
button.    The Output MPA PT Selection dialog box 
appears.

All Output MPA-type Precision Transforms stored on your system are listed.

2.    Double-click on the desired PT or folder.



Completing a configuration

When you finish selecting PTs, you are ready to save the 
selections as a configuration.    Use the options on the 
File menu to save and name the current PT selections as 
a configuration ready for use with Aldus PhotoStyler.

The following information describes the Color Configure 
Menu bar, including the File, Delete, and View menus 
and options.    The Help menu, also available from the 
Color Configure Menu bar, is discussed in "Getting Help,"
earlier in this manual.

File, Delete, and View menu options allow you to save 
and manage configurations, import and convert third 
party device color profiles, delete Precision Transforms, 
and view Precision Transform attributes.



To go to any of the following topics, click on its title:

    Multiple Dialog Boxes

    Selecting Precision Transforms

    PT Selection Options

    To Add a PT to the Current Configuration

    Viewing PT Attributes

    Types of Precision Transforms

    Selecting a Monitor PT

    Selecting an Input PT

    Selecting Input Effects PT

    Selecting an Output PT

    Selecting Output Effects PT

    Selecting an Output MPA PT

    Completing a Configuration



The File Menu

Use the options in the File menu to create, manage, and 
print configurations as well as select preferences, Import 
third-party device color profiles, and exit Color Configure.



New Configuration

Select New Configuration to create a new configuration 
of PTs.    This option clears the Color Configure dialog box,
preparing the dialog box for a new configuration of 
Precision Transforms.    For the first configuration you 
create, all Color Configure dialog box fields display "(No 
Selection)," indicating no PTs are selected.    With one or 
more saved configurations, the selected Monitor PT 
appears in the Monitor field.

The system allows you to create and save up to fifteen 
configurations.    The New Configuration option is grayed-
out when you reach this limit.

When you have unsaved PT selections, you may receive 
a confirmation message when you select New 
Configuration.    

For more information on confirmation messages, see 
"Preferences,".

Select Yes to save a Configuration, select No to erase the
selections, or select Cancel to exit New Configuration 
and return to the Color Configure dialog box without 
creating a configuration.



Open Configuration

Select Open Configuration to select and open a 
configuration for reference or modification.    The Select 
Configuration dialog box appears, displaying all 
configurations currently stored on the system.    A double
arrow icon to the left of the configuration name indicates
the default configuration.

Select the configuration you want and click OK.    The Color Configure dialog box appears 
with the Precision Transforms selections saved in the configuration.

When you have unsaved PT selections, you may receive 
a confirmation message when you select Open 
Configuration.    

For more information on confirmation messages, see 
"Preferences,".

Select Yes to save and open a Configuration, select No to
erase the selections, or select Cancel to exit Open 
Configuration and return to the Color Configure dialog 
box without creating a configuration.



Revert

Use Revert to return the PT selections in the Color 
Configure dialog box to restore the selections that 
displayed when you opened or last saved the 
Configuration.    This option is only available when you 
modify a configuration without saving it.



Save Configuration

Use Save Configuration to store changes to the current 
configuration without modifying the configuration's 
name.

The KODAK PRECISION Color Configure progress box 
displays as Color Configure composes new PTs.    If you 
make a new Monitor PT selection, previously saved 
configurations are updated with the PT when you select 
Save Configuration.    The progress box redisplays for 
every saved configuration.

When finished, the configuration is saved on the system 
and can be referenced, printed, or modified as desired.



Save Configuration As

Use Save Configuration As when you want to store a new
or modified current configuration with a new name or 
overwrite an existing configuration with the current 
configuration.

When you select Save Configuration As, the Save As 
dialog box displays, listing the names of existing 
configurations.

When creating a new configuration, enter a name in the selection box at the top of the 
dialog box.    Save the configuration with a name indicating the type of configuration created.
For example, you might create a configuration to correct a group of images with a yellow 
cast, and name it "corr4yellow."    Or, you can create a different configuration for every type 
of output device you use and save each configuration with a portion of the output device 
name, such as "ColorGet," "AppPrntr," and so on.

You cannot name a new configuration with a name 
already in use for another configuration.    When a name 
you choose is already in use, the OK button is grayed-
out.

Click OK to store the configuration or Cancel to return to 
the Color Configure dialog box.    If you make a new 
Monitor PT selection, previously saved configurations are
updated with the PT when you select Save Configuration.
The progress box redisplays for every saved 
configuration.

You can double-click on an existing name to place a copy
of the name in the selection box.    From here, you can 
save the configuration with a different version of the 
name or you can overwrite the selected configuration 
with the PTs selected in the current configuration.



Click Yes to replace the configuration shown in the selection box with the current 
configuration of PTs, or click No to cancel and return to the Save As dialog box.

The KODAK PRECISION Color Configure progress box displays as Color Configure composes 
new PTs.

When finished, the configuration is saved on the system and can be referenced, printed, or 
modified as desired.

You can create and save up to fifteen configurations.

If desired, you can print the information in the 
configuration to keep a hardcopy record of its contents. 

See "Print Configuration".

You can also save modifications to a previously saved 
and opened configuration.    Save Configuration 
overwrites the PT selections that display in the Color 
Configure dialog box with the currently selected PTs.



Rename Configuration

Use Rename Configuration to change the name of an 
existing configuration.    You must assign a new name 
one that is not assigned to an existing configuration.    
When you select Rename Configuration, the Rename 
Configuration dialog box appears.

The name of the current configuration displays to the right of Old Name: and also appears in
the New Name: option.    Type the new name in the New Name: field.    Click OK to save the 
configuration with the new name.    You cannot name a new configuration with a name 
already in use for another configuration.    When a name you choose is already in use, the OK
button is grayed out.

Click Cancel to return to the Color Configure dialog box.



Set Default Configuration

Set Default Configuration allows you to choose a 
configuration as the default configuration.

The default configuation is indicated with a double-arrow
icon.    When you select Set Default Configuration, the 
Select Configuration dialog box appears, displaying the 
list of configurations.

Select the desired configuration and click OK.    The Setting Default Configuration dialog box 
appears.    The progress bar indicates the percent complete as you wait.    When the process 
is complete, the dialog box closes and the default configuration is created.



Print Setup

Use Print Setup to specify printer options.    When you 
select Print Setup the Print Setup dialog box displays.

All of the standard Print Setup dialog box functions apply.    Use the dialog box to select a 
printer, the page orientation, the size and source of the paper, margins, memory, fonts, and 
additional options.    A Help feature is included with the Advanced Print Setup options.    For 
more information, see the Microsoft Windows User's Guide.

When you finish your selections, click OK to save the 
selections or Cancel to ignore your selections.



Print Configuration

Select Print Configuration to print the current 
configuration, using the printing settings selected in the 
Print Setup dialog box.

All of the standard Windows functions apply.    Use the dialog box to select the Print Range, 
the dpi setting, and the amount of copies.

To print all configurations, click All.    To print the current configuration only, click Selection.    
Click Setup to access the Print Setup dialog box and adjust current settings 

See "Print Set Up" earlier in this chapter for more 
information.

To print, click OK.    The information in the configuration, 
including the PT attributes for each PT in the file, is 
printed.





Preferences

The Color Configure Preferences dialog box contains 
several functions that allow you to adjust and set Color 
Configure controls and functions.

Confirm Boxes. Select the Confirm boxes to turn on or off confirmation dialog boxes that 
display when saving modified configurations and deleting Precision Transforms. 



When you first use Color Configure, both the Save and Delete boxes are automatically 
selected.    Deselect a box to disable its associated confirmation dialog box.

Attributes. Click Attributes to choose the amount of 
Precision Transform information that displays when you 
choose View in the PT Selection dialog boxes.    You can 
choose an abbreviated version, with general detail, or 
the full version, to view all available PT information.    The
shortened version is adequate for most users.    When 
you first use Color Configure, the shortened view is 
selected as the default.    If you would like to view all PT 
information, click View All and/or Print All.

Location of Private Database File. You can designate the 
location of the database for Color Configure by entering 
a drive and directory name in the Location of Private 
Database File box.

Location of Import Filters. Specify the location of 
Dynamic Link Libraries (DLLs) third-party filter programs,
which import their device color profiles for use with Color
Configure.    DLLs are typically located in the directory 
where the third-party program installs the filters.    
Designate the location by entering the drive and 
directory containing the DLLs in the Location of Import 
Filters box.    For example, to use import filters in the C: 
drive, in a directory called \kcm\imports, enter c:\kcm\
imports.

For more information on using filters, refer to the user's 
guide for the thirdparty filters you use.

Fonts for Printing.... Click on the Fonts for Printing... 
option to display a standard font selection dialog box 
from which you can choose a font to be used when 
printing configurations.    For more information on 
selecting fonts, see the Microsoft Windows User's Guide.

Save/Cancel. When you finish setting up the Preferences 
dialog box, click Save to save the current selections or 
click Cancel to ignore the selections and return to the 
previous Preferences settings.





Import Filters

Select Import Filters to access filters (DLLs).    The Select 
Import Filter window opens.    For more information on 
using a filter, refer to the filter manufacturer's user's 
guide.

A list of filter names appear in the Filters: box.    When no filters are present, the box is blank.

To select a filter:

1.    Click the filter name from the Filters: box to select it.  
A selected filter name appears highlighted.

2.    Click Select to open the filter or Cancel to return to 
the Main window.

When the name of the desired filter does not appear in 
the list, specify the location of the filter by selecting the 
drive and directory that contains it.    For example, to 
access filters in the C: drive, in a directory called \
windows\system, double-click c from the Drives: box and
double-click windows and system in the Directories: box. 
Names of filters in the selected path appear in the 
Filters: box.



Exit

Use Exit to quit Color Configure.



To go to any of the following topics, click on its title:

    New Configuration

    Open Configuration

    Revert

    Save Configuration

    Save Configuration As

    Rename Configuration

    Set Default Configuration

    Print SetUp

    Print Configuration

    Preferences

    Import Filters

    Exit



Deleting Precision Transforms and 
Configurations

Delete Precision Transforms and configurations you 
infrequently or no longer use to conserve disk space.

Use the Delete menu, accessed from the Color Configure
Menu bar, to select the type of PT to be deleted, then 
select the name of the Precision Transform you want to 
delete.

Note: When you delete Precision Transforms and 
configurations from your system, they are permanently 
erased .

When deleting PTs, the following apply:

·    Delete one PT at a time
·    PTs stored in a configuration cannot be deleted
·    Maintain at least one Monitor PT in the Color Configure
database at all times

Precision Transforms saved within a configuration appear
grayed-out, indicating they are unavailable for deletion .

To delete a Precision Transform
1.    Pull down the Delete menu to select the type of PT.    
For example, to delete an Input type PT, select the Input 
option.

The PT Selection dialog box appears, displaying the PTs available for deletion.



2.    Click on the name of the PT you want to delete.

3.    Click Select to accept your selection .
Depending on how you configured your Preferences dialog box, you may receive a Confirm 
Delete box.  See "Preferences" earlier in this chapter for more information.    If you do not 
receive a Confirm Delete box, the Precision Transform is automatically deleted.    If the 
Confirm Delete box appears, the selected PT name displays in the box.

4.    Click Yes to remove the PT from the system or No to 
ignore the selection and return to the Color Configure 
dialog box.

5.    Repeat steps 2 through 4 until you have removed all 
unneeded Precision Transforms.    Select Cancel when 
finished.

To delete a Configuration
1.    Pull down the Delete menu to Configuration.    The 
Select Configuration dialog box appears with the name 
of the current configuration selected.



2.    If you do not want to delete the current configuration, select the desired configuration.

3.    Click OK.

Depending on how you configured your Preferences dialog box, you may or may not receive 
a Confirm Delete box.    See "Preferences" earlier in this chapter for more information . 

When you do not receive a Confirm Delete box, the 
configuration is automatically deleted.    If the Confirm 
Delete box appears, the name of the selected 
configuration displays in the box.

4.    Click Yes to remove the file from the system or No to 
ignore the selection and return to the Color Configure 
dialog box.

5.    Repeat steps 2 through 4 until you have removed all 
unneeded configurations.    Select Cancel when finished.



To go to any of the following topics, click on its title:

    To Delete a Precision Transform

    To Delete a Configuration



Using the Menu Bar to View PT Attributes

Precision Transform attributes can be viewed from the Menu bar
as well a from the PT Selection dialog boxes (see "Viewing PT 
Attributes" earlier in this chapter).    The information you view is 
for the PT selected in the current configuration.

Pull down the View menu to select the type of PT, such as 
Monitor, Input, or Output Pull down to Input Effects or Output 
Effects to view Effects PTs.    The names of the available PTs 
display to the right of each option .

Depending on how you configured your Preferences dialog box, you may view all of the 
information available for a PT.  See "Preferences" earlier in this chapter for more information

To View PT attribute information
1.    Pull down the View menu to the type of PT.
For example, to view the configuration's Input PT attributes 
select the Input option.    The View PT Input dialog box appears, 
displaying the name of the PT at the top left.



2.    When you finish viewing the information, click Close to return to the Color Configure 
dialog box.



Ending Your Color Configure Session

When you finish configuring PTs, save your configuration, then 
choose Exit from the File menu to quit Color Configure.    Your PT
configuration is ready to use with Aldus PhotoStyler.



 Glossary

Please click on a term for an explanation:

Acquire
Attribute
Configuration
Color space 
Current configuration 
Dialog box 
Default 
EPS file format 
Export
File 
Filename
Image 
Import 
KODAK PRECISION Color Processor (CP) 
Microsoft Windows 
Precision Transform (PT)



Acquire:    To obtain an image from a scanner or Photo CD disc.



Attribute:    Object or characteristic associated with a Precision Transform.        Typical 
attributes are names and models of devices, description of PTs, the date and time a PT 
was created, and so on.



Configuration:    A group of Precision Transforms.



Color Space    A method of assigning a coordinate system to clearly identify colors.



Current Configuration:    The configuration displayed in the Main dialog box. The current 
configuration can be saved, modified, or deleted.



Dialog Box:    A type of menu that requests or provides information. Use dialog boxes, such
as the Color Configure Main dialog box, to select options or enter information before you 
continue with the program.



Default:    A menu or program selection automatically made by a computer unless 
otherwise indicated or changed.    For example, the default configuration automatically 
displays each time you start up Color Configure.



EPS File Format:    An acronym for Encapsulated PostScript, a file format that can be read 
by many PostScript language-structured software applications.



Export:    A means of sending an image in a specified format for use with another system 
or software application.



File:    A named collection of related data organized for a specific purpose.



FileName:    The name assigned to a file for the purpose of storing and retrieving.    Color 
Configure filenames follow DOS filenaming conventions.



Image    The visual representation of the original subject on the monitor.



Import:    A means of sending an image in a specified format for use with another system 
or software application.



KODAK PRECISION Color Processor (CP):    A Kodak-supplied software module that performs
the color-space transformations required by the Color Management System.



Microsoft Windows:    A graphical user interface (GUI) for the personal computer by 
Microsoft Corporation.



Precision Transform (PT):    A set of device-independent or device-dependent data in a 
format defined by Eastman Kodak, that enables accurate conversion between one 
representation of color and tonal scale and another.
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